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reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or 
display any part, in any form, or by any means. Reverse engineering, disassembly, or 
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Preface vii 

Preface 
This document describes the following steps to install the Oracle Gateway Device 
Handler (OGDH) and the Oracle Payment Interface (OPI). 

• Installing the OGDH  
• Installing the Oracle Payment Interface  
• Configuring the POS for the OPI using the OGDH  

Audience 
This document is intended for installers of the OPI and OGDH. 

Customer Support 
To contact Oracle Customer Support, access My Oracle Support at the following URL: 
https://support.oracle.com 

When contacting Customer Support, please provide the following: 
• Product version and program/module name 
• Functional and technical description of the problem (include business impact) 
• Detailed step-by-step instructions to re-create 
• Exact error message received and any associated log files 
• Screenshots of each step you take 

Documentation 
Oracle Hospitality product documentation is available on the Oracle Help Center at 
http://docs.oracle.com/en/industries/hospitality/ 

Revision History 
Date Description of Change 

December 2017 • Initial publication 

March 2019 • Documentation updates 

 
 
 

https://support.oracle.com/
http://docs.oracle.com/en/industries/hospitality/
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1  Pre-Installation Steps 
Before Installing the OPI 

IF UPGRADING OPI, YOU MUST READ THE UPGRADING THE OPI SECTION 
FIRST. 

Complete the following tasks before installing: 

• The OPI application requires Microsoft .NET Framework version 4.0 or higher.   
• You must uninstall previous versions of MPG before installing OPI 6.2 
• You cannot upgrade from previous versions of MPG to OPI 6.2  
• You can upgrade from OPI 6.1 (6.1.0.9) and higher to OPI 6.2 
• You can upgrade from MGDH 6.1 (6.1.0.9) and higher to OGDH 6.2 
• You cannot upgrade from MGDH 6.1.1.X to Native Driver 6.2 (must upgrade 

then switch to Native configuration) 
• You cannot run upgrade from 6.1.1.X to 6.2 as unattended/silent (due to 6.1.1.X 

installation program differences between 6.2) 
• Verify with the merchant to setup table service (TSR) or quick service (QSR), or 

both.  QSR does not support tips. 
• Verify with the merchant if activating the Refund functionality, the merchant 

must control the privilege for this function.  
• Verify with the merchant if they offer a guest the option to get cash back with 

their purchase, then activate the Sale & Cash option. This is only available for 
QSR.  

• Confirm Microsoft Visual C++ 2010 is installed on the computer where OGDH 
and OPI are installed.  

• Transactions from previous OPI versions will not settle or Void once system is 
upgraded to OPI 6.2. All transactions must be settled/finalized before upgrading. 

• Oracle Payment Interface requires at least 6 GB of free disk space.  
• You must install both OGDH and OPI as a System Administrator. 
• OPI 6.2 does not install a database.  If doing a clean install of OPI, a database 

must be installed first.   
• If upgrading from OPI 6.1 or higher, the existing MySQL configuration data will 

be migrated to 6.2 but the old transaction data will not include 

During the installation you must confirm the following: 

• Merchant IDs  
• Receipt “Header” and “Trailer” details 
• Tender Media numbers for each card type 
• IP address of the OPI Server  
• If there is an existing MySQL database installed, then the SQL root password is 

required. 
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• Workstation IDs and IPs that integrate with the PIN pad. 
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2  Network Considerations 
You must consider the following points for the network: 

• OPI listens on the TCP port 5098 for incoming messages from OGDH, this port 
must be open internally on the merchant’s network. 

• The port for the PIN pad depends the partner, confirm with the partner and 
confirm the corresponding port is open. 
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3  9700 Server Configuration 
Adding an Interface 

To configure the 9700 Server you must add a new interface.  
1. In the Enterprise Management Console, go to the Interface tab. 
2. Define the following Interface values. 

Table 3-1 Insert Interfaces 

Interface Value 

System Name OGDH 

Service Type 
Communication Type 
Timeout 
ISL Script Name 

PMS /SIM 
TCP/IP 
210 
pms7 

 

3. Select the check box to enable the option to Use 19 Digit Reference Entry for 
PMS Inquiries. 

 

 
Figure 3-1 EMC Interfaces tab 
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Configuring RVC 
To configure the RVC, link the interface OGDH to each RVC. 

1. Go to the Enterprise Management Console. 
2. Go to the RVC Parameters tab and link the OGDH interface to each RVC. 

 
Table 3-2 EMC RVC Parameters 
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If the RVC is configured in QSR mode, then activate the options below: 
• Select the check box Do Not Prompt for Tips (No Overtendering if Charge Tip 

is Required).  
• Select Allow Fast Transactions. 

 
Figure 3-2 EMC RVC Parameters General Options 
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If using the TSR mode, do not activate this option. On the Format tab, configure and 
enable the following options for the TSR RVCs: 

1. Define the Number of Guest Check Information Lines as 30. 
2. Select the check box Skip Blank Lines When Print or Display Guest Check Info 

Lines. 

 
 

Figure 3-3 EMC RVC Parameters Format Options 
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Employee Configuration 
1. Go to the Employee Maintenance tab, select the Cashier employee class. 
2. Select the check box to activate the ISL Employee Option #4 option to define 

the employee class that can process a refund. 

 
Figure 3-4 EMC Employee Maintenance - Employee Classes 
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3. Enable the Authorize/Perform Closing of Checks with a Negative Balance 
Tenders option. 

 
Figure 3-5 EMC Employee Maintenance Tenders Options 
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Service Charges 
If the merchant provides a Cash Back option, then add a new Service Charge for the 
CashBack option. This is the same as the Open Amount Service Charge. You can skip this 
step if the merchant does not activate the SalesCash function. 

 
If the merchant provides a Gift Card Cashout option, then add a new Service Charge for 
the Gift Card Cashout option. Using the settings below, you can skip this step if the 
merchant does not activate the Gift Card Cashout function. 
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Configuring Tender Media Records 
Configure the following options for the credit/debit card tenders. 

1. In the Enterprise Management Console, go to the Tender Media tab. 
2. Select the Options tab and select the category Interface Options.  
3. Activate the PMS and Credit Card use 19 Digit Acct Number option. 

 
Figure 3-6 EMC Tender Media Options 

 
To configure the credit card options: 

1. Go to Options tab select Credit Card Options. 
2. Deactivate all options and remove the floor limit/preambles list. 
3. Enable the No Credit Card Length Check option. 
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To configure the POS options: 

1. Go to the Options tab and select POS Behavior, to active the following options: 
• Assume Paid in Full 
• Reference Entry Required 

2. Deactivate the following options: 
• Mask Account Number 
• Encrypt Tender/Media Reference Entry 

3. Link the tender to Open amount Service Charge for TSR environments. 
4. Add the debit tender option the same way you would for normal credit card 

tenders. 
5. Add the new tender Gift Card option the same way as a normal credit card 

tender. You can skip this step if the merchant does not activate the Gift Card 
function. 

6. Add the new tender SaleCash option the same way as a normal credit card 
tender. You can skip this step if the merchant does not activate the SaleCash 
function. 

Note: The SaleCash tender is only supported when utilized in a Quick Service 
Restaurant (QSR) environment. 

 

 
Figure 3-7 EMC Tender Media POS Behavior Options 
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Touch Screen Design 
First, contact the Oracle Hospitality Consulting Team for confirmation, and then if 
required, add the following buttons to the payment screen. The key types are Functions 
and you can link them to the OGDH interface. 

Table 3-3 Table Service Restaurant (TSR) Payment Screen 

Field  Value  

CC PAY SIM INQ #2 

CC REFUND SIM INQ #4 

CC AUTH SIM INQ #8 

CC FINAL SIM INQ #9 

TAB AUTH SIM INQ #12 

BALANCE INQUIRY SIM INQ #14 

CC REPRINT SIM INQ #7 

CC REPOST SIM INQ #16 

MANUAL AUTH SIM INQ #15 

REFUND MANUAL 
GC Function 
AUTH CNP 

SIM INQ #11 
SIM INQ #10 
SIM INQ #20 

Table 3-4 Quick Service Restaurant (QSR) Payment Screen 

Field Value 

QSR SALE SIM INQ #1 

SALE CASH SIM INQ #5 

CC REFUND SIM INQ #4 

BALANCE INQUIRY SIM INQ #14 

CC REPRINT SIM INQ #7 

CC REPOST  SIM INQ #16 

REFUND MANUAL 
SALE CNP 
GC Function 

SIM INQ #11 
SIM INQ #6 
SIM INQ #10 
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OPI shares the VOID touchscreen key with the 9700 POS. Using the VOID key you can: 
• Void the transaction 
• Add Tips (for TSR only) 

 
 

Menu Item Configuration 
The two open menu items that need to be created are Gift Card activate transaction and 
Gift Card reload transaction. 

The menu item class -- "GC Open Item" 
Setup the following for the menu item class. 

• Menu Item class name   - "GC Open Item" 
• Reference required 
• Open-priced Menu Items 
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Menu item -- "GC Activate" 
Setup the menu item master--"GC Activate". 

 
Define menu item. 

• Menu Item class name   - "GC Open Item" 
• Menu Item Master name   - "GC Activate" 
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The Menu Item -- "GC Topup" 
It is defined as same as "GC Activate". 
Set up the menu item master--"GC Topup". 
Define menu item. 

• Menu Item class name   - "GC Open Item" 
• Menu Item Master name   - "GC Topup" 
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4  Installing the OGDH Driver  
Installing OGDH on the 9700 Server 

1. In Microsoft Windows, log in as an administrator, and then run the 
OGDH_OPI_6.2.0.0.exe file. 

2. Click Next. 
3. A Welcome screen displays.  Click Next. 
4. A Checking dependencies screen displays.  Click Next. 
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5. Select the install location, and then click Next. 
6. On the Ready to Install the OGDH screen, click Install. 
7. On the Conenct to 9700 database screen, click Connect or Skip DB 

Connection. 
If you connect to 9700 database you need select the DB type, enter the Host or IP 
address, Port, DB name/SID, Username and Password 

 

8. Select a currency from the drop box, and then click Next 
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9. In Configuration details for property, set the Device Merchant ID, Mode, 
Receipt Header/Trailer for each Revenue center. 

 

 

 

• For the header, do not exceed 6 lines. For each line do not exceed 33 
letters or special characters 

• For the trailer, do not exceed 12 lines. For each line do not exceed 33 
letters or special characters 
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10. In Tender mapping configuration, Link the correct tender number for 
each tender.  Leave unused tenders blank. 

 

11. In Extra Tender mapping configuration, if you need use extra tenders, 
enable the extra tenders option, and link the correct tender number for 
each tender.  Leave unused tenders blank. 
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12. In Transaction configuration, Select the options required for the merchant, 
and then click Next.  

 
Adjust Tip:  Enable if the ability to adjust tip amount is needed. 
Adjust Tip 2:  Enable if you need to adjust tips with a transaction that 
already has a tip. 
Allow Tab Auth:  Enable if initial authorizations are allowed. 
Gift Card Support:   Enable if gift cards will be sold. 
Use GC denominated value:  Enable if gift cards are sold in pre-
determined amounts. 

If disabled, the POS asks the cashier to input the amount for the gift card 
activation. 

Local Printer:  Enable Local Printer 
List Local Printer:  List Local Printer 
Print Failed Receipt:  Enable if vouchers should print when a card is 
declined. 
 

13. In configuration details, enter all the value. 
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Host / IP Address:  Enter IP address of the OPI server PC. 
Port:  Port used to communicate to OPI. 
Tab Auth Amount:  Initial authorizations will default to this preset 
amount. 
Receipt Limit Amount:  Enter the amount, below which vouchers should 
not print. 
GC activation menu item: Enter the GC activation menu item. 
GC top-up menu item: Enter GC top-up menu item. 
POSEOD Device Merchant Id: Make sure there are no duplicate MIDs, 
and then click Next. 

14. Click Save on the OPI Service Configuration screen. 
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Point-of-Sale (POS) End-of-Day (EOD) 
You can use the Microsoft Windows Task Scheduler to run the OPI POSEOD 
using the following configuration details. 

Table 4-1 Microsoft Windows Task Scheduler Settings 

Temporary Table 

Name OPI POSEOD 

Description Generates the OPI transaction report 

Trigger Daily 

Action Start a program 

Program/script Browse to find the POSEOD.exe in 
OGDHDriver directory 

Add arguments (optional) The upper level of the POSEOD.exe path 

Start in (optional) The upper level of the POSEOD.exe path 

For more information on how to setup the Microsoft Windows Task scheduler visit the 
Microsoft website at: http://www.microsoft.com 
 
 

http://www.microsoft.com/
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5  Installing the OPI 
OPI Installation Steps 

1. Copy Oracle Payment Interface-6.2.exe to the Server and double-click it to launch 
the install. 

2. Select your language, and then click OK. 

3. Click Next on the Welcome to the InstallShield Wizard for Oracle Payment Interface 
screen. 

4. Click Next on the OPI Prerequisites screen appears. 

 
 

The Setup Type screen appears. 

• Complete:  All program features will be installed. 

• Custom:  Select which program features you want installed.  
Recommended for advanced users only.  

5. Make a selection, and then click Next. 
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If you selected the Custom install option, the Select Features screen appears with 
the following options: 

a. Database Schema 
b. OPI Services 
c. Configuration Tool 

All three of these features must be installed.  It is just a matter of whether they are 
all installed on the same computer or on separate computers.   

6. Select the features to install on this computer, and then click Next. 

The Choose Destination Location screen appears. 

7. Accept the default installation location or click Change… to choose a different 
location, and then click Next. 

8. Click Install on the Ready to Install the Program screen. 

The Setup Status screen displays for a few minutes. 

9. The Setup Type screen appears. 
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10. Select the database type being used, and then click Next. 

Note: OPI does not install any database, so the database must already be installed. 

 
 
The Database Server screen appears. 
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The Name/IP: field defaults to localhost. This should be left as localhost if the 
OPI database is installed on the same computer. If the database is installed on 
another computer, the Name or IP address of that machine should be entered 
here. 
 
Note:  If the database type is MySQL, and you cannot use localhost for the 
Name/IP field, then some commands must be run manually on that MySQL 
database before proceeding. See MySQL Grant Permission in the OPI Installation 
and Reference Guide for instructions. Setup will not complete if this is not done. 

11. Accept the default Port # of 3306 (for MySQL), and then click Next. 

The Database Server Login screen appears. 

 
 

12. Enter the credentials for the DBA user of the database type selected, and then click 
Next. 

• For MySQL the Login ID: = root 
• For other database types the DBA user name/Login ID may be different. 
• Enter the correct password for the DBA user. 

The Database User Credentials screen appears. 
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• User Name:  Create a new user.   

• Password:  Create a password.  

- Password is case sensitive 

- Should be at least 8 characters in length 

- Must have at least one upper case letter, one lower case letter, one 
number and one special character from the following list:   !@#$%^&* 

13. Confirm the password, and then click Next. 

14. Click OK on the Database connection successful dialog.  

15. Click OK on the Database Configuration operation successful dialog.  

The Configuration Tool Superuser Credentials screen appears. 
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• User Name:  This can be any user name.  It does not have to be a Windows 
account user. 

• Password:  Create a password.   

- Password is case sensitive 

- Should be at least 8 characters in length 

- Must have at least one upper case letter, one lower case letter, one 
number and one special character from the following list:  !@#$%^&* 

16. Confirm the password, and then click Next. 

17. Click OK on the Create SuperUser operation successful dialog. 

The Configuration Tool Connection Settings screen appears. 
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• Host:  May be left at 127.0.0.1 if the OPI configuration server is installed 
on this PC. Otherwise, specify the name or IP address of the PC where 
the OPI configuration server will be installed. 

• Leave the default Port of 8090. 

18. Click Next. 

The Configuration Tool Passphrase screen appears. 

 



 

5-8 Installing the OPI 

Passphrase:  The passphrase is case sensitive, should be at least 15 characters in 
length and must have at least one upper case letter, one lower case letter, one 
number and one special character from the following list:  !@#$%^&* 

19. Enter a passphrase, confirm it, and then click Next. 

After a brief pause, the Configuration Wizard launches.

 
a. Select POS, Select OGDH, and then click Next. 

 

20. Enter and confirm the passphrase, and then click Next 
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21. OPI Payment interface  

Enable Mutual Authentication:  Enable this option only if the PSP has provided 
the certificates and passwords for it.   

Private Key Cert. Password:  Enter the password and confirm it. 

Root Certificate Password:  Enter the password and confirm it. 

• OPI Mode:  Select either Middleware or Terminal. 

• Middleware: Fill in primary host connection information and the 
failover Host information (if provided). 

• Terminal:  Select correct Port. 

• If using Mutual Authentication, see the Mutual Authentication section 
in the Oracle Payment Interface Installation Reference Guide. 

 

22. Add merchant, and then complete the required merchant information fields. 
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23. Complete the following Merchant Terminal Configuration fields: 

Workstation ID:  Enter the workstation number from the POS system. 

Terminal IP:  Enter the IP address of the pinpad device 

24. Click Next. The POS Merchants screen appears. 

25. Click Close to advance to final screen. 

 
26. Click Finish to reboot.  

If a reboot cannot be done at the moment, you must stop and then start the OPI 
Service for current settings to take effect.
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6  Upgrading the OPI 
VERY IMPORTANT:  Read and follow the upgrade directions. 

Note: OPI 6.1 and higher can be upgraded to OPI 6.2. 

OPI Upgrade Steps 
1. Right-click and Run as Administrator the OraclePaymentInterfaceInstaller_6.2.0.0.exe 

file to perform an upgrade. 

2. Select a language from the drop-down list, and then click OK. 

3. Click Next on the Welcome screen to proceed with the installation.  

Prerequisites for the installation will be checked, including the required free drive 
space, details of the host environment, and the Java version that is present. 
 

 
 

4. Click Next on the OPI Prerequisites screen. 
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5. Click OK on the OPI Upgrade screen. 

 
 
6. WARNING! You must click Yes. 

IF YOU CLICK NO, YOU WILL HAVE BOTH OPI 6.1 AND OPI 6.2 INSTALLED 
AND NEITHER WILL WORK. 

Explanation:  OPI will migrate the existing MySQL configuration information, but 
all previous OPI applications will be removed before the new files are installed. 

7. Choose a Destination Location. Accept the default installation location or click 
Change… to choose a different location. 

8. Click Next. 

The Ready to Install the Program screen displays. 

9. Click Install. 

The Setup Status screen displays for a few minutes. 

Setup Type 

For database type, select MySQL. No other database type is supported for 
upgrades. 

Database Server 

Name/IP – The Hostname or IP Address used for communication to the MySQL 
database. This must be left at the default of localhost. 

Port # – The Port number used for communication to the database  

Database Server Login 

DBA user 
Login ID: root 
Password: root user password for MySQL database. 

Database User Credentials 

User Name: This must be a new user name.  It cannot be the same user from the 
6.1 install. 
Password: Password for the new database user. 

Configuration Tool Superuser Credentials 

User Name: This can be any user name. It does not have to be a Windows account 
user. 
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Password: Create a password, and then confirm it.  

Configuration Tool Connection Settings 

Host: May be left at 127.0.0.1 if the OPI configuration server is installed on this 
PC. Otherwise, specify the name or IP address of the PC where the OPI 
configuration server will be installed. 
Port: Leave at 8090. 

Configuration Tool Passphrase 

Enter and confirm a passphrase. 
Click Next. 
The Configuration Wizard launches. 
Continue to follow on-screen directions, verifying settings as you go. 

POS Merchants 

On the Merchants screen, click the wrench icon to the right of the existing 
merchant. 
Verify the merchant settings are correct. 

Merchant Pay At Table Configuration 

If using Pay@Table, review the tender settings carefully as there are new fields 
that will not be pre-populated from the previous OPI install. 

Continue to follow the on-screen directions. 

InstallShield Wizard Complete 

Click Finish to allow a reboot. 
If you cannot immediately reboot, you must stop and then start the OPI Service 
for the current settings to take effect. 
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7  Not Supported Functionality 
 
 
Not supported with RES Native OPI solution:  

• Gift Cards (SVC works as usual thru workstation. Not thru OPI or PED.)  
• Balance Inquiry  
• Void a refund (RES limitation)  
• Debit (RES Native OPI)  
• SaleCashBack (RES Native OPI)  
• Backup OPI Server 

 
Not supported with RES OGDH: 

• Incremental Auth 
• Void a Refund (RES limitation) 
• CC voice / Manual entry in QSR revenue center 
• Backup OPI Server 
• Voiding the tender from a SaleCashBack transaction. 

 
Not supported in the e7 Native OPI driver solution: 

• Gift Cards 
• Balance Inquiry 
• Void a refund (e7) 
• Debit (e7) 
• SaleCashBack (e7) 
• Multiple Revenue Centers (e7) 
• Memo Tender (e7) 
• CC Voice/Manual CC for QSR (offline sale) 
• Backup OPI Server 
• Backup server mode (e7) 
• Pay@Table 
• Transaction Void (e7) 
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